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Lab 7.1.9b Introduction to Fluke Protocol Inspector 
 

 

Objective  
This lab is a tutorial demonstrating how to use the Fluke Networks Protocol Inspector to analyze 
network traffic and data frames. This lab will demonstrate key features of the tool that can be 
incorporated into various troubleshooting efforts in the remaining labs. 

Background / Preparation 
The output in this lab is representative only. Output will vary depending on the number of devices 
added, device MAC addresses, device hostnames, which LAN is joined, and so on. 

This lab introducing Protocol Inspector will be useful in later troubleshooting labs as well as in the 
field. While the Protocol Inspector (PI) software is a valuable part of the Academy program, it is also 
representative of features available on other products in the market. 

Options for conducting this lab. 

1) Use Protocol Inspector or Protocol Expert in a small controlled LAN that is configured by the 
instructor in a closed lab environment as shown in the figure above. The minimum 
equipment should include a workstation, a switch, and a router.  

2) Perform the steps in a larger environment such as the classroom or the school network to 
see more variety. Before attempting to run PI or PE on the school LAN, check with the 
instructor and the network administrator. 

At least one of the hosts must have the Protocol Inspector software installed. If the lab is done in 
pairs, having the software installed on both machines means that each person can run the lab steps. 
However, each host may display slightly different results. 
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Step 1 Configure the lab or attach a workstation to the school LAN 
Option 1. If the closed lab environment is selected, cable the equipment as shown above and load 

the configuration files into the appropriate routers. These files might be preloaded. If not, 
obtain them from the instructor. These files should support the IP addressing scheme as 
shown in the figure above and the table below. 

Configure the workstations according to the specifications as in the figure shown above and table 
below. 
 

Host #1 Host #2 

IP Address: 192.168.1.20 IP Address: 192.168.2.10 

Subnet mask: 255.255.255.0 Subnet mask: 255.255.255.0 

Default Gateway: 192.168.1.1 Default Gateway: 192.168.2.1 

Option 2. If option 2, connect to school LAN, is selected, simply connect the workstation, with PI or 
PE installed, directly to a classroom switch or to a data jack connected to the school LAN. 

Step 2 Start Protocol Inspector EDV program 
From the Start menu, launch the Fluke Protocol Inspector EDV program.  
 

Note: The first time the program is 
run, a message will appear that asks, 
“Do you have any Fluke analyzer 
cards or Fluke taps in your local 
system?”  

If using the educational version, click 
on No. If answering yes or if the 
following screen appears, just click 
on OK without selecting any ports. 

There are four main Protocol Inspector views, which include the following: 

• Summary View 

• Detail View 

• Capture View of Capture Buffers 

• Capture View of Capture Files 

The program opens in the Summary View. This view shows several windows used by the tool. The 
Resource Browser window in the upper left corner shows the only monitoring device that is 
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available, which is the NDIS 802.3 Module (NIC) of the host. If there were Protocol Media Monitors, 
they would be displayed with the associated host devices. The Alarm Browser on the left side and 
Message Area at the bottom will be covered later. 

The Monitor View, which is in the main window on the upper right, monitors one resource per 
window in a variety of viewing options. The example below and probably the startup screen show no 
information in the Monitor View window. The Stop in the upper-left corner of the Monitor View 
window confirms that no monitoring is occurring. 

 

Resource Browser 

Message Area

Monitor View NIC 

 
 

Step 3 Start the Monitor / Capture process 

To start the monitoring/capturing process, use the Start  button or Module | Start from the menu 
system. The Utilization chart should start showing activity like the graphic below: 
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The word Arm should appear where Stop had been before. If opening the Module menu, notice that 
Stop is now an option while Start is muted. Do not stop the process yet. Restart it again if it is 
stopped. 

The tabs at the bottom of the window show the resulting data in a variety of forms. Click on each and 
note the result. Transmit (Tx), Alarms, and Alarm Log will be blank. The following is the Received 
(Rx) frames, which indicates that Broadcast and Multicast frames are being received, but they may 
not show any Unicasts. 
 

 
Using the console connection to the router, ping the monitoring host (192.168.1.20 or 192.168.2.10), 
and notice that Unicast frames appear. Unfortunately, the errors shown in the third column will not 
appear in the lab exercise unless a traffic generator like the Fluke Networks OptiView product has 
been added. 
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The Description tab 
reveals the MAC address, 
manufacturer, and model 
of the NIC. It also shows 
which Error Counters are 
on. 

Take a few minutes to 
become familiar with the 
tabs and the scroll 
features of the window. 

Step 4 View Details 

To go to the Detail View window click on the Detail View  button in the toolbar or double click 
anywhere on the Monitor View chart. This will open a second window that should look something like 
the following, after maximizing the Utilization / Errors Strip Chart (RX) window. 
 

 
 
Note: If necessary, activate all toolbars on the View menu. 
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Initially, the chart output is the same as before. However, there are many more toolbar and menu 
options than in the Summary View. Before looking at these features, confirm that the Chart and 
Table tabs show the same information that was seen earlier. 

Like all Windows compliant programs, placing the mouse over a button brings up a screen tip briefly 
identifying the purpose of the button. As the mouse moves over the buttons, notice that some are 
muted. This means that the feature is not appropriate under the current circumstances. In some 
cases, it is not supported in the educational version. 

Note: There is a complete display of the toolbars and what they do in the Appendix at the end of 
this lab. 

Click on the Mac Statistics  button to see the Rx frame table data displayed in another format. 
The result should be obvious. Maximize the resulting window. The one piece of new information is 
the Speed, which shows the NIC transmission rate. 

Click on the Frame Size Distribution  button to see a distribution of the size frames being 
received by the NIC. Placing the mouse over any bar will display a small summary like the one 
shown below. Maximize the resulting window. 

 

Try the Pie, Bar, and Pause  buttons in the upper-left corner. Note that the Pause stops the 
capture, so click on it again to resume the capture. Look at both the Table and Chart tab displays as 
well.  

With the sample configurations, the student should be getting mainly small frames, because the only 
thing happening is routing updates. Try using the extended Ping feature from the router Console 
connection, and specify 100 pings with a larger packet size. 

If maximizing each new display, return to any previous view by using the Window menu. The student 
can also Tile the windows. Experiment with the Window menu features and then close any unwanted 
views. 

Click on the Protocol Distribution  button to see a distribution of the protocols being received 
by the NIC. Placing the mouse over any bar will display a small summary panel. Maximize the 
resulting window. 
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Try each of the buttons and tabs to see the results. The Net button shows only network protocols. 
The 323 button refers to the H323 Voiceover IP protocols. Depending on the version of Protocol 
Expert or Inspector that is being used, this button may be called VoIP. Look at the Frm (frame) and 
the Abs Bts (absolute bytes) and Rel Bts (relative bytes) to see the results. Remember that the 
Pause button stops the capture. 

Click on the Host Table  button to see the MAC stations and related traffic.  
 

 
 
Notice the Spanning Tree, AppleTalk, and OSPF traffic. Be sure to look at the Table tab to see the 
actual values. 

Click on the Network Layer Host Table  button to see the network (IP/IPX) stations and 
related traffic.  
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Any pings and any additional hosts that might have added to the configuration will impact the actual 
addresses that appear on the right. 

Click on the Application Layer Host Table  button to see the network station traffic by 
application.  
 

 

Experiment with the next three  buttons. They create host-to-host matrices for MAC, 
Network, and Application layer conversations. The following is an example of the Network Layer 
(IP/IPX) conversations.  
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Of the next two  buttons, the first is the VLAN button that shows network traffic on VLANs.  
This sample does not use VLANs. Remember this button when troubleshooting VLANs later. 

The second button creates a matrix comparing MAC and Network station addresses to names. In the 
following example the second row is a Novell station. 
 

 

The Name Table  button opens the current name table for viewing or editing. 
 

 

The Expert View  button shows the expert symptoms discovered. These statistics are how the 
PIs try to point out potential problems. The underlined options bring up additional detail windows if 
there are any values recorded.  The sample for this lab will not show much, but it will look over the 
options for debugging ISL, HSRP, and other types of problems that will be seen in later labs. 
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Step 5 Stop the capture process 

To stop the frame capture to look at individual frames use the Stop  button or Module | Stop from 
the menu. 

Once the capture has been stopped, click on the Capture View  button. With the education 
version, a message box appears announcing that the capture is limited to 250 packets. Just click 
OK. 

The resulting window can be a little overwhelming at first. Maximize the window to hide any other 
windows open in the background. 
 

 
 
In looking over the results, note that there are actually three horizontal windows open. The top 
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window lists the captured packets. The middle window shows the detail of the selected packet in the 
top window, and the bottom window shows the HEX values for the packet. 

By positioning the mouse over the borders among the three windows, a line mover or two-headed 
arrow will appear. This allows the distribution of space for each window to be changed. It may be 
advantageous to make the middle window as large as possible and leave five to six rows in each of 
the other two, as shown above. 

Look over the packets listed in the top window. DNS, ARP, RTMP, and other types of packets should 
be found. If using a switch, there should be CDP and Spanning Tree packets. Notice that as rows 
are selected in the top window, the contents of the other two windows change. 

Select information in the middle window, and notice that the HEX display in the bottom window 
changes to show where that specific information is stored. In the following example, selecting the 
Source Address (IP) shows HEX values from the packet. 

 
Note also the color coding makes it easier to locate information from the middle window in the HEX 
window. In the following example with a DNS packet, the data in the Data Link Control (DLC) section 
of middle window is purple, while the Internet Protocol (IP) section is green. The corresponding HEX 
values are the same colors. 
 

 
 
Notice in the above example the EtherType is 0x0800. This indicates that it is an IP packet. Notice 
the MAC addresses for both the Destination and Source hosts as well as where that data is stored in 
the HEX display. 

In the same example, the next section in the middle window is the User Datagram Protocol (UDP) 
information, which includes the UDP port numbers. 
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The structure of the middle window changes for each type of packet.  

Take a few minutes to select different packet types in the top window, and then look over the 
resulting display in the other two windows. Pay particular attention to the EtherType, any port 
numbers, as well as source and destination addresses, which include both MAC and network layer. 
There should be RIP, OSPF, and RTMP or AppleTalk packets in the capture. Make sure that the 
important data can be located and interpreted. In the following RIP capture, notice that this is a RIP 
version 2 packet. The multicast destination address is 224.0.0.9,and  that the actual route table 
entries can be seen. What would the multicast destination address be in version 1? _____________ 
 

 
 
If there are any CDP packets, figure out the platform. The following is from a Catalyst 1900 switch. 
 

 
 
Experiment until comfortable with the tools. 

 

Step 6 Save the captured data 

To save captured data, use the Save Capture  button or choose File | Save Capture from the 
menu system. Depending on the version of Protocol Expert or Inspector that is being used, the File 
menu may offer "Save Current Section" instead of "Save Capture". Accept the All option by using 
the Continue button. The student can save just a range of captured frames with this window. 
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Use a proper file name and store the file on the appropriate disk. If the CAP extension is showing 
when this window opens, make sure it remains after typing the name. 

 

Use the Open Capture File  button and open the file called Lab3-2 PI Lab.cap. If it is not 
available, then open the file that was just saved.  

The student is now using the Capture View of Capture Files. There is no difference in tools, but the 
title bar at the top of the screen indicates that a file is being viewed rather than a capture in memory. 

Step 7 Examine frames 

Select a frame in the top window and try the  buttons. The arrows by 
themselves move up or down one frame. The arrow with single line is top or bottom of the current 
window, while the arrow with two arrows is the top or bottom of the entire list. The arrow with the T 
also moves to the top of the list. 

Use the Search  buttons to perform searches. Type text like OSPF in the list 
box. Then click on the binoculars, and it will move from one OSPF entry to the next. 

Experiment until comfortable with the tools. 

Reflection 
a. How might this tool be used in troubleshooting? 

___________________________________________________________________________ 

b. Is all of the data on the network being analyzed? 

___________________________________________________________________________ 

c. What is the impact of being connected to a switch? 

___________________________________________________________________________ 
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Appendix: PI Toolbars 
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